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Preventing Toll Fraud 
“Toll fraud” is the unauthorized use of your telecommunications system by 
an unauthorized party (for example, a person who is not a corporate 
employee, agent, subcontractor, or working on your company’s behalf).  
Be aware that there may be a risk of toll fraud associated with your 
system and that, if toll fraud occurs, it can result in substantial additional 
charges for your telecommunications services.

Avaya Fraud Intervention
If you suspect you are being victimized by toll fraud and you need 
technical support or assistance, call the appropriate Avaya National 
Customer Care Center telephone number. Users of the MERLIN®, 
PARTNER®, and System 25 products should call 1 800 628-2888. Users 
of the System 75, System 85, DEFINITY® Generic 1, 2 and 3, and 
DEFINITY® ECS products should call 1 800 643-2353.

Providing Telecommunications Security
Telecommunications security (of voice, data, and/or video 
communications) is the prevention of any type of intrusion to (that is, 
either unauthorized or malicious access to or use of your company’s 
telecommunications equipment) by some party.

Your company’s “telecommunications equipment” includes both this 
Avaya product and any other voice/data/video equipment that could be 
accessed via this Avaya product (that is, “networked equipment”).

An “outside party” is anyone who is not a corporate employee, agent, 
subcontractor, or working on your company’s behalf.  Whereas, a 
“malicious party” is anyone (including someone who may be otherwise 
authorized) who accesses your telecommunications equipment with either 
malicious or mischievous intent.

Such intrusions may be either to/through synchronous (time-multiplexed 
and/or circuit-based) or asynchronous (character-, message-, or 
packet-based) equipment or interfaces for reasons of:

• Utilization (of capabilities special to the accessed equipment)
• Theft (such as, of intellectual property, financial assets, or 

toll-facility access)
• Eavesdropping (privacy invasions to humans)
• Mischief (troubling, but apparently innocuous, tampering)
• Harm (such as harmful tampering, data loss or alteration, 

regardless of motive or intent)

Be aware that there may be a risk of unauthorized intrusions associated 
with your system and/or its networked equipment.  Also realize that, if 
such an intrusion should occur, it could result in a variety of losses to your 
company (including, but not limited to, human/data privacy, intellectual 
property, material assets, financial resources, labor costs, and/or legal 
costs).

Your Responsibility for Your Company’s Telecommunications Secu-
rity
The final responsibility for securing both this system and its networked 
equipment rests with you – an Avaya customer’s system administrator, 
your telecommunications peers, and your managers.  Base the fulfillment 
of your responsibility on acquired knowledge and resources from a variety 
of sources including but not limited to:

• Installation documents
• System administration documents
• Security documents
• Hardware-/software-based security tools
• Shared information between you and your peers
• Telecommunications security experts

 To prevent intrusions to your telecommunications equipment, you and 
your peers should carefully program and configure your:

• Avaya-provided telecommunications systems and their inter-
faces

• Avaya-provided software applications, as well as their under-
lying hardware/software platforms and interfaces

• Any other equipment networked to your Avaya products
Avaya does not warrant that this product or any of its networked 
equipment is either immune from or will prevent either unauthorized or 
malicious intrusions.  Avaya will not be responsible for any charges, 
losses, or damages that result from such intrusions.
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Welcome

Purpose

This book explains how to install and configure DEFINITY Translator ATM WSP 
Manager (DTA) software, how to test the installation, and how to troubleshoot it. 

Prerequisites

Installing DTA requires familiarity with data networking concepts, knowledge of 
your company’s data network, and proficiency with Windows. 

Intended Audience

We wrote this book for PC Administrators who are responsible for their company’s 
network of DEFINITY systems.

Conventions Used in This Book

In this book, we use the following typographical conventions:

■ We use bold type for emphasis and for any information that you should 
type; for example: save translation.

■ We use Courier font for any information that the computer screen displays; 
for example: login.

■ We use arrows to indicate options that you should select on cascading 
menus; for example: “Select File>Open” means choose the “Open” option 
from the “File” menu.

■ We use small type for any keyboard control keys that you should press; for 
example: Enter.
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Trademarks

Intuity is a trademark, and AUDIX®, CONVERSANT®, and DEFINITY® are 
registered trademarks of Avaya, Inc. Acrobat® is a registered trademark of Adobe 
Systems Incorporated. Symantec® and pcAnywhere® are U.S. registered 
trademarks of Symantec Corporation and its subsidiaries. Windows® and 
Windows NT® are trademarks or registered trademarks of Microsoft Corporation.

Additional Resources

You may find the following additional resources helpful.

For help using DTA, look in the online help. For more detailed information on ATM 
WSPs, see DEFINITY ECS ATM Installation, Upgrades, and Administration. 
555-233-124.

For help with complex DEFINITY switch administration tasks, use the DEFINITY 
ECS Administrator’s Guide, 555-233-502, which explains system features and 
interactions in detail. 

For a complete list of DEFINITY books, refer to the Avaya Publications Catalog, 
available at: http://www.lucent.com/enterprise/documentation

Tell Us What You Think!

Let us know how this book measured up to your expectations. Your opinions are 
crucial to helping us meet your needs! Please complete and return the comment 
card at the front of this book. Optionally, send us your comments by mail, fax, or 
e-mail, as follows:

Mail: Avaya Inc.
Avaya University
DTA Documentation Team
22-2h24
11900 North Pecos Street
Denver, CO 80234-2703
USA

Fax: DTA Documentation Team
+ 1 303 538 1741

E-mail:document@avaya.com
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How to Get This Book on the Web

To view or download the latest version of this book, perform the steps listed next.

1. Install your internet browser.

Most computers are sold with browsers already installed.

2. Get access to the Internet.

If you do not already have access to the Internet, contact your local Internet 
Service Provider (ISP).

3. Set up your browser preferences.

Refer to the documentation that came with your browser.

4. Install Adobe Acrobat Reader with Search, version 3.0 or later.

This is available on your DNA CD-ROM or from: http://www.adobe.com.

5. Access http://support.lucent.com

6. Wait a moment while the web page prepares the popup menus.

7. Position your cursor over Online Services (at the top left of the 
screen).

8. From the popup menu, click Documentation.

9. Click Recent Documents.

10. Enter 555-233-223 (the document number).

You can also order the book over the web. To do so, visit 
http://www.lucent.com/enterprise/documentation/ and search for document 
number 555-233-223.

How to Get Other Books on the Web

You can access the books for many other Avaya products by visiting 
http://www.lucent.com/enterprise/documentation/
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How to Order More Copies

To order this book, call or write us and request the following publication:

Order: Document Number:555-233-223
Issue: Issue  1
Date: December 2000

Call: Avaya Publications Center

USA
Voice: 1 800 457 1235
Fax: 1 800 457 1764

CALA & Asia/Pacific Regions: China, Caribbean, Latin America
Voice: + 1 317 322 6411
Fax: + 1 317 322 6699

EMEA Region: Europe, Middle East, Africa
Voice (in EMEA) +44 1 666 832 900
Fax (in EMEA) +44 1 666 832 213
Voice (in the US): + 1 317 322 6416
Fax (in the US): + 1 317 322 6699

North America Region: Canada, American Samoa, Bahamas, Canada, 
Cayman Islands, Guam, Jamaica, Virgin Islands, and West Indies

Voice: + 1 317 322 6619
Fax: + 1 317 322 6359

Write: Avaya Publications Center
2855 N. Franklin Road
Indianapolis, IN 46219-1344
USA

You can be placed on a standing order list for this and other Avaya documents. 
Standing order enables you to automatically receive updated versions of books or 
document sets, billed to account information that you provide. For more 
information, or to be put on a list, contact the Avaya Publications Center.
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Overview

DEFINITY Translator ATM WSP Manager (DTA) is a client-server application that 
allows you to upload translations from a DEFINITY switch and download them to 
multiple DEFINITY WAN spare processors (WSPs) simultaneously, according to a 
schedule you specify. This chapter explains roughly how the application works, 
explains security considerations, and summarizes the installation process.

The Upload and Download Process

DTA copies translations from a DEFINITY switch to its WSPs as follows. 

Uploading Translations from the switch

When DTA copies translations from a DEFINITY switch to its WSPs, it first makes 
a connection with the switch over an Ethernet LAN or WAN, via the C-LAN board 
on the switch. It logs in to the switch using an “administration” login ID and 
password that has already been set up on the switch and specified in DTA. It 
issues the save translations command on the switch, and if successful logs off 
and disconnects. It then reconnects using the “upload/download” login, and issues 
the upload translations command. (If the save translations command fails, 
DTA will proceed with the second command only if you have specified that DTA 
should do so.) The switch translations are uploaded to DTA, and then DTA 
disconnects from the switch. DTA logs the success or failure of the upload in its 
log, which you can view from the DTA user interface. If the translations were 
uploaded successfully, DTA keeps a copy before downloading the translations to 
the WSPs.
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Modifying Translations for the WSPs

DTA does not download an exact copy of the main DEFINITY switch’s translations 
to the WSPs. If it did, it would overwrite critical connectivity information that allows 
the WSP to communicate with other systems. Instead, after uploading translations 
from the main switch, DTA makes some minor adjustments to the translations that 
are necessary for the translations to work on the WSP. For example, after 
uploading translations, DTA changes IP address, port, and node name 
information, as appropriate, to work on the given WSP. 

Downloading Translations to the WSPs

Once DTA has uploaded translations from the DEFINITY switch, it issues the 
status atm wsp command on the main switch. If the WAN Processor Role field 
contains a value of “pending”, no WSP data is available and DTA logs an error in 
the status log. If the WAN Processor Role field contains any other value, DTA can 
then display the name, number, and link status of each WSP in the network. 

DTA then connects and logs in to each WSP, using login IDs and passwords that 
have previously been set up on the WSPs and specified in DTA. DTA issues the 
status atm wsp command on each WSP. If the WAN Processor Role field 
contains a value of “spare” and the State field contains a value of “standby,” then 
DTA issues the save translations removable-media command, and then the 
download translations command. If the WAN Processor Role and the State 
fields contain any other values, then DTA aborts the save translations and the 
download and logs an error. After DTA downloads translations successfully, it 
issues the display circuit 1 command to determine where the ATM-EI board 
resides, and then it issues a reset system 3 command to reboot the WSP in a 
forced-standby mode. This terminates the connection between the WSP and DTA. 

Five minutes later, DTA attempts to reconnect to the rebooted WSP. If it fails, it 
tries again in another five minutes. If it fails again, it logs an error in the status log. 
If it succeeds, DTA then performs the following administration on the translations: 
it issues the busyout atm pnc 1 command; it issues the remove atm pnc 1 
command; and it makes the following changes on the change system-parameters 
maintenance form of the WSP: it enters “spare” in the WAN Processor Role field; 
it enters the WSP number (gathered from the main switch) in the WSP Number 
field; it enters the number of minutes (gathered from the DTA user) after which the 
WSP will take over in the event of a main switch failure in the WSP Active Time 
field; and it enters the previously determined location of the ATM-EI board in the 
A-PNC Board Location field. Finally, it issues a save translations command on 
the WSP, and disconnects.
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Scheduling Uploads/Downloads

DTA lets you specify when you want to copy translations. You can copy them 
immediately, or schedule the copy to occur once, daily, or weekly.

Limited Administration of WSPs

DTA lets you set the number of minutes after which a WSP will take over in the 
event of a main switch failure. All other WSP administration commands are 
accessible only from a System Administration Terminal (SAT) or system 
administration application, such as DEFINITY Network Administration (DNA) or 
DEFINITY Site Administration (DSA). 

Security

DTA has no login and password protection. Unauthorized use of DTA is prevented 
only through the login and password required by Windows, and the logins and 
passwords required by the DEFINITY switches and WSPs. Once DTA has been 
installed and configured, DTA stores the login IDs and passwords of the main 
switch and its WSPs on the DTA server, which means from that point forward, only 
your Windows security prevents unauthorized users from gaining access to these 
devices. However, all that an unauthorized user could do with DTA is copy 
translations from the main switch to its WSPs. Using DTA, users cannot manually 
modify translations between uploading them from the switch and downloading 
them to the WSP, which means users do not have any way through DTA to 
introduce errors or sabotage the WSP translations.

If you have a service agreement with Avaya, or if you want Avaya support during 
DTA’s warranty period, you must install a copy of pcAnywhere on the DTA 
computers you want Avaya to support. For the required version number of 
pcAnywhere, see ‘‘Understanding System Requirements’’ on page 11. If used 
incorrectly, pcAnywhere can be a security risk. It is your responsibility to protect 
your network from unauthorized use. Before installing pcAnywhere, see the 
guidelines in ‘‘Understanding pcAnywhere Security’’ on page 30.
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Installation Checklist

The installation will follow a process like the one listed below.

1. Connect DTA computers to main DEFINITY switches and WSPs.

We recommend that PC administrators or telephone technicians perform 
the following steps.

a. Connect DTA computers, and the DEFINITY switches and WSPs 
that it supports, to a LAN or WAN, following the instructions in 
Chapter 4, ‘‘Connecting the Hardware’’ (page 13).

2. Prepare main DEFINITY switches and WSPs for DTA.

We recommend that a DEFINITY switch technician perform the following 
tasks.

a. Install main PPN, ATM-PNC, and WSPs, if you have not already. 

For instructions on installing main PPNs and WSPs, refer to 
DEFINITY ECS Release 9 Installation and Test for Multicarrier 
Cabinets. For instructions on installing ATM-PNC, refer to DEFINITY 
ECS Release 9 ATM Upgrades, Installation, and Administration.

b. Install, administer, and test C-LAN boards on all DEFINITY switches 
and WSPs that DTA will support, if you have not already. (page 18)

c. Set up asynchronous links, if you have not already. (page 19)

d. If you will be using Access Security Gateway (ASG) on a DEFINITY 
ECS system that DTA supports, and if it is not already enabled, then 
contact Avaya to have this feature enabled (page 21).

e. Have Avaya enable the “DEFINITY Network Admin” option for each 
DEFINITY switch and WSP that DTA supports, if it is not already 
enabled (page 22).

f. Create an “Upload/Download” login and “Administration” login for 
each DEFINITY ECS system and each WSP that DTA supports, if 
these do not already exist (page 23).

3. Prepare computers for DTA.

a. Upgrade existing computers (if necessary) to meet the hardware 
and software requirements specified on page 11.

b. Ensure TCP/IP connectivity between the DTA server and all DTA 
clients, as well as between the DTA server, the main switch, and all 
of its WSPs. 

Make sure they can PING each other. Troubleshoot problems with 
the LAN/WAN administrator.

c. Set the PC’s time (page 35).
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4. Give Avaya access to your system.

This step applies if you have a maintenance support agreement with 
Avaya, or if you want Avaya to be able to support you during DTA’s 
warranty period. We recommend that PC administrators perform the 
following tasks.

a. Install modems and pcAnywhere on all computers that you want 
Avaya to be able to access to support DTA.

b. Provide Avaya’s Technical Service Center (TSC) the phone number 
or IP address to access DTA computers.

5. Install DTA.

We recommend that PC administrators perform the following tasks.

a. Install DTA client and server software (page 29).

b. Reboot.

6. Configure DTA.

We recommend that PC administrators perform the following tasks.

a. Specify the main switch connection information (page 36).

b. Specify the WSP connection information (page 37).

7. Test the Installation.

We recommend that PC administrators perform the following tasks.

a. Test connections to devices (page 39).

b. Have DTA copy translations from the main switch to the associated 
WSPs and examine the Status Log for errors.

8. Troubleshoot, if appropriate.

We recommend that PC administrators and network administrators 
collaborate to perform the following tasks.

a. Troubleshoot hardware connections.

b. Troubleshoot software connections (page 40).

c. Troubleshoot uploading/downloading.
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Getting Help with the Installation

If you are located within the United States and require assistance installing DTA, 
contact your local Avaya representative for options and details. Please allow a 
4-week lead time to ensure that your requested due date can be met.

If you are located outside the United States and require assistance installing DTA, 
contact your Avaya local representative or dealer. Please allow a 4-week lead 
time to ensure that your requested due date can be met.
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Understanding System Requirements

PC Requirements

Any computer you use to run the DTA client or server software should meet the 
following requirements:

*If client and server software are on the same computer, add these space requirements 
together.

In addition, DTA computers must be on the same LAN or WAN as the DEFINITY 
ECS systems and the ATM WSPs that will DTA support.

IP addresses on the DTA client and server can be static or DHCP. If you are using 
DHCP, you must refer to the DTA server by host name.

DTA can run on the same computer with DNA 3.0 and later, and with pcAnywhere 
9.0. 

Parameter Client Server

Operating 
System

minimum: Windows 95

recommended: Windows 2000

minimum: Windows NT

recommended: Windows 2000

Other Software minimum: none minimum: none

recommended: DNA, 
pcAnywhere 9.0

RAM 64 MB 64 MB

Available Disk 
Space

50 MB* 50 MB, plus
15 MB for each switch or WSP*

CD-ROM Drive Yes Yes

Network Type Ethernet Ethernet
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Enabling Avaya Remote Services

If you have a maintenance agreement with Avaya for support of DTA, you are 
required to install a modem and a copy of Symantec’s pcAnywhere on the 
computers that you want Avaya to be able to access. pcAnywhere enables Avaya 
personnel to remotely troubleshoot and correct problems on your system. 

Before installing pcAnywhere, please read the pcAnywhere security guidelines on 
page 30, and visit the following web site for the latest pcAnywhere security 
information: http://www.symantec.com/pcanywhere/index.html

Switch and WSP Requirements

DTA supports only Release 9.1 or greater of DEFINITY ECS systems. In addition, 
your switches and WSPs must meet the following requirements:

1. A C-LAN board must be installed, asynchronous links must be configured, 
and the board and configuration must be tested and fully functioning, both 
on the main switch and each of the WSPs that DTA will support.

2. The main switch and the WSPs you want to work with DTA must all be on 
the same LAN or WAN, and that must be the same LAN or WAN that 
supports all of the DTA computers.
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Connecting the Hardware

To function properly, DEFINITY Translator ATM WSP Manager (DTA) must be 
connected to your DEFINITY system and ATM WSPs via a DEFINITY C-LAN 
board. Figure 1 illustrates one way to connect your DTA computers to your 
DEFINITY systems and WSPs.

Connecting to DEFINITY via CLAN 
Board

Figure 1. Connecting DEFINITY systems and WSPs via Network

Connect the equipment as shown in Figure 1.

cydrdta LJK 103100

DEFINITY ECS

C-LAN

259A 
adapter

RJ-45 RJ-45

LAN

DTA computer

Category 5
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Preparing Switches for DTA

Before you can use DEFINITY Translator ATM WSP Manager (DTA) to copy 
translations to WSPs, the following activities must happen. A number of these 
activities require you to call Avaya. To avoid calling repeatedly, read all of the 
sections first, and then determine what activities you need Avaya to perform, 
before you call.

NOTE:
The instructions for Steps 4 through 8 (below) supercede the analogous 
instructions published in Issue 2 of the DEFINITY ECS Release 9 ATM 
Upgrades, Installation, and Administration book, until the time that errata 
pages for that book are published.

Overview

1. Install the main DEFINITY switch, if you have not already.

Refer to DEFINITY Made Easy Tools on the DEFINITY Documentation 
Library CD. 

2. Install the ATM-PNC, if you have not already.

For instructions on installing ATM-PNC, refer to DEFINITY ECS Release 9 
ATM Upgrades, Installation, and Administration.

3. Install the WSPs, if you have not already.

Refer to Refer to DEFINITY Made Easy Tools on the DEFINITY 
Documentation Library CD. Verify that the WSP configuration matches the 
main PPN configuration. 

■ If the main PPN is standard reliability, a port carrier can be in the B 
position.

■ If the main PPN is high reliability, the B position must be empty 
because that is where the duplicate control carrier is in the main 
PPN (see Figure 2).

■ The TN2305/TN2306 ATM expansion interface and the TN799B/C 
C-LAN circuit packs are in the same carriers and slots.
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Figure 2. Main PPN and WSP sharing location of control and port carriers

4. Check the health of the main switch. (page 17)

5. Administer the WSPs on the main switch. (page 18)

6. Install the C-LAN circuit pack. (page 18)

7. Administer asynchronous links. (page 19)

8. Test C-LAN connectivity to the LAN. (page 20)

9. If you want to use Access Security Gateway (ASG), have Avaya enable it 
on your switches and/or WSPs. (page 21)
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10. Have Avaya turn on the DEFINITY Network Administration customer option 
on each switch and WSP that you plan to use with DTA. (page 22)

Skip this step if you have DNA and it has been set up to support this switch 
or WSP. In that case, this step would have been done as part of the DNA 
installation process. 

11. Create a login on each DEFINITY switch and WSP that DTA can use to 
upload or download translations, or use existing logins that have these 
permissions. If you create new logins for this purpose, have Avaya enable 
them. (page 23)

12. Create a login on each DEFINITY switch and WSP that DTA can use for all 
other administration, or use existing logins that have this permission. If you 
create new logins for this purpose, have Avaya enable them. (page 25)

After you complete the above preparations, you can install and configure DTA, as 
described in the next chapter. (page 29)

Check the SPE on the main PPN

1. Type status spe and press Enter to check the health of the SPE. 

For standard reliability systems:

■ The Standard field shows active, In Service

For high reliability systems:

■ The Standby Refreshed field shows yes

■ The Standby Shadowing field shows on

■ The Standby Handshake field shows up

2. Log off if not logged in as init.
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Administer the WSPs on the main PPN

1. Log in as init.

2. Type change system-parameters customer-options and press Enter and 
go to screen 2.

3. Set the ATM-PNC field to y. 

4. Set the ATM WAN Spare Processor field to y.

5. Press Enter to effect the changes.

6. Type add atm wsp number where the number is the number of the WSP 
from 1 to 7.

7. Type the name of the WSP in the Name: field. 
Can be up to 15 alphanumeric characters.

8. Type the priority number of the WSP in the Priority: field from 1 to 7.

9. Type the ATM address for the WSP.

10. Repeat steps 6 through 9 for each WSP.

Install the C-LAN Circuit Pack

To install a TN799B/C C-LAN circuit pack, you need the following items:

■ An unoccupied port slot (must be same slot in each WSP as in main PPN)

■ A 10 BaseT Ethernet connection into your local area network.

■ A valid, unused IP address on your network for each C-LAN circuit pack.

From the rear of the cabinet:

1. Connect the 259A connector to the backplane connector corresponding to 
the TN799B/C slot.

2. Connect one end of the CAT5 cable to the 259A connector. Connect the 
other end to the customer’s network.

From the front of the cabinet:

! CAUTION:
When adding or replacing any hardware, be sure to ground yourself against 
electrostatic discharge (ESD) by wearing a grounded wrist strap.

NOTE:
The TN799B/C circuit pack is hot-swappable, so you do not need to power 
down the carrier to install it.

3. Insert the TN799B/C circuit pack into the port slot identified earlier.
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Administer Asynchronous Links

Refer to DEFINITY ECS Release 9 Administration for Network Connectivity, 
Chapter 5 “Asynchronous Connectivity for DEFINITY Applications and Adjuncts,” 
Tasks 1 through 5 (pages 251 through 258). In addition, you may need the 
following information, as well.

NOTE:
For Task 5, Defining asynchronous IP service types, you may find 
that, although you can have up to 8 concurrent sessions, only 5 are 
generally available; the other 3 are reserved for a direct connection to 
the switch and maintenance. The direct connection ID number is 
always 0; the C-LAN, serial, and subsequent maintenance ports are 
assigned the next available ID numbers (1-7).

Freeing Up a Session

On occasion, you may get the following error message when you try to log in:

All administration ports are busy (si/csi)

Login resources unavailable (r)

This is because no administrative ports are available for log in—all 5 ports are in 
use. To free up a session:

1. On the direct-connect access terminal, log in.

2. Type status login-ID and press Enter. Look at the Active Command column 
to review any activity in progress. Note the ID number of a session with a 
blank Active Command field.

3. Type reset login-ID number and press Enter to drop that session.

4. Type status login-ID and press Enter to verify that the session cleared.

5. Log in to the available session ID.



DEFINITY Translator ATM WSP Manager Release 3.0
Installation and Configuration  555-233-223  

Issue 1
December 2000

Preparing Switches for DTA 
20Test C-LAN Connectivity to the LAN 

5

Test C-LAN Connectivity to the LAN

To test the external IP connections, ping the C-LAN gateway and, if possible, ping 
a known computer connected to your network. If everything is configured 
correctly, the Result column on the Ping Results screen reads pass. If it reads 
fail or abort, verify the IP-address information and check the connectivity, 
including the cabling.

1. Type ping ip-address nnn.nnn.nnn.nnn board UUCSS and press Enter. 
The variable nnn.nnn.nnn.nnn is the IP address of the TN799B/C C-LAN 
circuit pack and UUCSS is the cabinet, carrier, and slot of the TN799B/C 
C-LAN circuit pack.

2. Type ping ip-address nnn.nnn.nnn.nnn board UUCSS and press Enter. 
The variable nnn.nnn.nnn.nnn is the IP address of the customer’s 
gateway and UUCSS is the cabinet, carrier, and slot of the TN799B/C 
C-LAN circuit pack.

3. Type ping ip-address nnn.nnn.nnn.nnn board UUCSS and press Enter. 
The variable nnn.nnn.nnn.nnn is the IP address of another computer 
beyond the gateway and UUCSS is the cabinet, carrier, and slot of the 
TN799B/C C-LAN circuit pack.

The TN799B/C C-LAN circuit pack is now installed in the DEFINITY carrier and 
connected to the IP network.

ping ip-address 192.168.10.21                                                   
                                                                                
                          PING RESULTS

  End-pt IP        Port      Port Type  Result    Time(ms)  Error Code

  192.168.10.21    01C19 CLAN PASS 10 1124 
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Enabling ASG on Your Switch

ASG is an optional security feature that prevents unauthorized persons from 
accessing your DEFINITY switch. To determine if the ASG feature is enabled on 
your switch, complete the following steps:

1. Log in to your switch.

2. Type display system-parameters customer-options and press Enter. 

If the Access Security Gateway field has a value of y, then your 
switch has the ASG feature. 

If your switch does not have the ASG feature enabled, and you want it, you can 
order it by completing the following steps:

1. Call Avaya (see numbers below).

2. Give Avaya your Installation Location (IL) number.

3. Request that Avaya turn on the ASG customer option.

If you are calling from outside the United States, contact your Avaya 
representative or dealer.

If you are calling from the United States... Dial...

CT, DC, DE, MA, ME, NH, NJ, NY, PA, RI, VA, VT, WV 1-800-632-0900

AL, AR, FL, GA, KS, KY, MO, MS, NC, SC, TN 1-800-922-1523

IA, IL, IN, MI, MN, ND, NE, OH, SD, WI 1-800-572-0036

LA, OK, TX 1-800-527-6889

AZ, S. CA, NM, HI 1-800-829-8888

AK, N. CA, CO, ID, MT, NV, OR, UT, WA, WY 1-800-642-4690
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Enabling Your Switch to Work with DTA

Your DEFINITY switch or WSP will not work with DTA until Avaya turns on the 
DNA customer option on that system. This should already have been done if you 
are using DNA with this switch or WSP. 

To determine whether your system has the DNA customer option turned on, 
complete the following steps:

1. Log in to the switch or WSP.

2. Type display system-parameters customer-options and press Enter.

If the DEFINITY Network Admin field has a value of y, then the DNA 
customer option is enabled, and your switch will work with DTA. 

If this option is not enabled, you can enable it as follows:

1. Call Avaya (see numbers above).

2. Give Avaya your Installation Location (IL) number.

3. Request that Avaya turn on the DEFINITY Network Administration 
customer option.
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Creating the Upload/Download Login

On each DEFINITY switch and WSP that you will be using with DTA, there must 
be a login that DTA can use to upload translations (from the switch to the DTA 
server), or download translations (from the DTA server to the WSPs). The login 
does not have to be the same for the switch and the WSPs. 

Do you need to create this login?

Any login that has permissions to issue the upload, download translations, and 
logoff commands will work. If an appropriate login already exists on the main 
switch and WSPs, then go to ‘‘Creating the Administrative Login’’ on page 25. 

If you need to create this login

The following procedure creates a login that, for security purposes, can only issue 
the upload, download translations, and logoff commands. To create the login, 
complete the following steps:

NOTE:
To perform this task, you must have permissions on the DEFINITY switch to 
add and change logins.

1. Log into the DEFINITY ECS.

2. At the command line, enter add login <name>

Where <name> is the word you want to use as the login. 

3. Enter your password.

4. Verify that the Login Type: field is set to customer. 

5. Verify that the Service Level: field is set to non-super-user. 

6. In the Login’s password:  field, enter the password that you want to 
associate with the login.

7. In the Reenter Login’s password: field, enter the password again.

8. If you want this login to use ASG, then in the Access Security 
Gateway?  field, enter a y and complete the fields on page 2 of the form 
(described in the following table).

If you do not see this field, your switch does not have the ASG feature 
enabled. To enable it, see ‘‘Enabling ASG on Your Switch’’ on page 21.
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9. Press Enter to submit the form.

10. Call Avaya. (page 21)

11. Give Avaya your Installation Location (IL) number.

12. Give Avaya the login name you just added, and request that they enable 
the System Management Data Transfer Only? field on the first 
page of the Change Permissions form for your DEFINITY switch.

NOTE:
Only Avaya can set the System Management Data Transfer Only? 
field to y. DTA will not work with your switch until this is enabled.

Field Description

Blocked Enter y to temporarily disable the login ID from accessing 
the switch through ASG.

System Generated 
Secret Key?

To use ASG, either you or the switch must generate a 
Secret Key, which you must enter on the switch and in 
DTA when you are configuring it. Enter a y to have the 
switch generate the Secret Key.

Secret Key If you want to create your own Secret Key, enter it in this 
field. Be sure to note the Secret Key; you will need it to 
configure DTA and/or any response generation devices.

The Secret Key must conform to the following 
requirements:

■ It must be 20 digits long.

■ Each digit must be between 0 (zero) and 7, inclusive.

■ The last number must be 0 (zero).

■ The next-to-last number must be 0 (zero), 2, 4, or 6.

Expiration Date To disable this login after a certain date, enter the date in 
this field. If you enter a value in the Number of Sessions 
field, then the login will be disabled based on whichever 
criteria is satisfied first.

Number of 
Sessions

Enter the number of times this login ID can be used to 
access the switch (between 1 and 999). If you enter a 
value in the Expiration Date field, then the login will be 
disabled based on whichever criteria is satisfied first.

Restrict Days of 
Week

Enter y to restrict this login from accessing the switch on 
the specified day of the week.

Restrict From Time 
and Restrict To 
Time

Enter the time interval during which this login ID is blocked 
from accessing the switch.
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Creating the Administrative Login

DTA needs a login that it can use to issue all of the commands described in 
‘‘Downloading Translations to the WSPs’’ and ‘‘Limited Administration of WSPs’’ 
on page 7. The DTA administrative login is what DTA uses to make changes to 
your DEFINITY switch. DTA cannot make changes to your switch if you do not 
create this login. 

Do you need to create this login?

Any login will work that has permissions to issue the commands status atm wsp, 
display circuit 1, reset system 3, busyout atm pnc 1, remove atm pnc 1, save 
translations, and logoff. If an appropriate login already exists on the main 
DEFINITY switch and WSPs, then skip the remainder of this section. 

If you need to create this login

To create the administrative login, you must have permissions on the DEFINITY 
switch to add and change logins.

1. Access the DEFINITY System administration screens.

2. At the command line, enter add login <name>

Where <name> is the word you want to use as the Do not reuse DNA 
logins for this purpose.

3. Enter your password.

4. Verify that the Login Type: field is set to customer. 

5. Verify that the Service Level: field is set to super-user. 

6. In the Login’s password:  field, enter the password that you want to 
associate with the administrative login.

7. In the Reenter Login’s password:  field, enter the password again.
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8. If you want this login to use ASG, then in the Access Security 
Gateway? field, enter a y and complete the fields on page 2 of the form.

If you do not see this field, your switch does not have the ASG feature 
enabled. To enable it, see ‘‘Enabling ASG on Your Switch’’ on page 21.

9. Press Enter to submit the form.

10. At the command line, enter change permissions <name>.

Where <name> is the word you used as the login in Step 2. The system 
displays the Command Permission Categories form. 

Field Description

Blocked Enter y to temporarily disable the login ID from accessing 
the switch through ASG.

System 
Generated 
Secret Key?

To use ASG, either you or the switch must generate a 
Secret Key, which you must enter on the switch and in 
DTA when you are configuring it. Enter a y to have the 
switch generate the Secret Key.

Secret Key If you want to create your own Secret Key, enter it in this 
field. Be sure to note the Secret Key; you will need it to 
configure DTA and/or any response generation devices.

The Secret Key must conform to the following 
requirements:

■ It must be 20 digits long.

■ Each digit must be between 0 (zero) and 7, inclusive.

■ The last number must be 0 (zero).

■ The next-to-last number must be 0 (zero), 2, 4, or 6.

Expiration 
Date

To disable this login after a certain date, enter the date in 
this field. If you enter a value in the Number of Sessions 
field, then the login will be disabled based on whichever 
criteria is satisfied first.

Number of 
Sessions

Enter the number of times this login ID can be used to 
access the switch (between 1 and 999). If you enter a 
value in the Expiration Date field, then the login will be 
disabled based on whichever criteria is satisfied first.

Restrict Days 
of Week

Enter y to restrict this login from accessing the switch on 
the specified day of the week.

Restrict From 
Time and
Restrict To 
Time

Enter the time interval during which this login ID is blocked 
from accessing the switch.
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11. Set the fields to y to enable DTA to perform the listed activity.

Use the table below to decide which of the fields to set to y. 

The fields listed in the following table are for a basic switch configuration. 
Your switch may display more than the following fields. For help setting 
those fields, refer to the DEFINITY Enterprise Communications Server 
Administrator’s Guide, 555-233-502.

If this field is 
set to Y... Then...

Display Admin 
and Maint 
Data?

Setting this field to y allows DTA to issue status atm 
wsp and display circuit pack commands. The login 
you use for DTA administration must have this field 
set to y for DTA to work.

System 
Measurements?

Since this field applies only to vs/si systems, and C-LAN 
boards are not available for vs/si systems, this field is 
irrelevant for DTA purposes.

System Mgmt 
Data Transfer 
Only?

Only Avaya can set this field. You should have them 
set it to y only for your DTA Upload/Download login.

Administer 
Stations?

DTA can issue add, change, duplicate, or remove 
commands for stations, data modules, and associated 
features, such as abbreviated dialing, vectors, and 
routing tables. You do not need to set this field to y for 
DTA to work.

Administer 
Trunks?

DTA can issue commands to administer AAR/ARS, 
trunk groups, remote access, and route patterns. You 
do not need to set this field to y for DTA to work.

Administer 
Features?

Setting this field to y allows DTA to issue remove atm 
pnc and save translations commands. The login you 
use for DTA administration must have this field set 
to y for DTA to work.

Administer 
Permissions?

DTA can issue commands to administer logins and 
command permissions. You do not need to set this field 
to y for DTA to work.

Restricted 
Objects?

You can specify any objects that you want DTA not to 
be able to access, like stations, trunks, or hunt groups. 
You do not need to set this field to y for DTA to work.

Maintain 
System

Setting this field to y allows DTA to issue reset system 
3 and busyout atm pnc commands. The login you 
use for DTA administration must have this field set 
to y for DTA to work.
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12. Press Enter.

13. Call Avaya. (page 21)

14. Give Avaya your Installation Location (IL) number.

15. Give Avaya the login name you just added, and request that they enable 
the Maintain System field on the Change Permissions form for your 
DEFINITY switch.

NOTE:
Only Avaya can set the Maintain System field to y. DTA will not work with 
your switch until this is enabled.
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Installation Prerequisites

Before you install DTA, be sure that the computers you plan to install it on meet 
the hardware requirements listed in ‘‘Understanding System Requirements’’ on 
page 11.

DTA requires a functioning LAN or loop-back host to operate. The instructions in 
this section assume that your LAN is fully operational and that all DTA computers 
can PING each other. In addition, to install DTA, you must have a Windows login 
with Administrator privileges.

If your company has a support agreement with Avaya, you need to install a 
modem and a copy of Symantec’s pcAnywhere on all computers that will host 
DTA software. pcAnywhere enables Avaya Service personnel to remotely 
troubleshoot and correct problems on your system. For the required version 
number of pcAnywhere, see ‘‘Understanding System Requirements’’ on page 11. 
Once pcAnywhere is installed, contact Avaya’s Technical Service Center (TSC) 
(from the US: 1 800 242 2121; from outside the US, contact your Avaya 
representative or dealer.) Then give them the phone numbers or IP addresses 
they should use to access your DTA computers. 



DEFINITY Translator ATM WSP Manager Release 3.0
Installation and Configuration  555-233-223  

Issue 1
December 2000

Installing DTA 
30Understanding pcAnywhere Security 

6

Understanding pcAnywhere Security

Before you install a copy of Symantec’s pcAnywhere on any of your computers, 
read this section. 

You are responsible for the security of your data network and for preventing 
unauthorized individuals from accessing it. Therefore, exercise caution when 
using pcAnywhere. Having it installed does not pose a security risk; it must be up 
and running, and be configured to receive calls, before a remote user can enter 
the system. In addition, pcAnywhere offers a number of security features. 

Follow these guidelines to protect PCs with pcAnywhere installed:

1. Unplug the modem from the phone jack when pcAnywhere is not in use.

2. Only run pcAnywhere when necessary.

3. Do NOT publish the phone number for the modem that people use to 
access the computer.

4. Change your password after Avaya personnel leave your site and after 
Avaya personnel terminate a remote service session.

5. Configure the following pcAnywhere security options:

■ Require login names for callers.

■ Make passwords case sensitive.

■ Log all failed connection attempts.

■ Set a maximum number of login attempts per call.

■ Allow time to enter the complete login.

■ Disconnect if inactive.

6. Configure pcAnywhere to log remote call and online sessions.

For more information on pcAnywhere, including acquisition and security, visit the 
following web site:

http://www.symantec.com/pcanywhere/index.html
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Installing DTA

To install DTA, you must use a Windows login that has Administrator privileges. 
Then, complete the following steps:

1. Shut down all applications running on the computer.

2. Insert the DTA CD into the CD drive.

Wait a moment for the CD browser window to appear automatically. 

3. Click Install DTA.

The installation program extracts the necessary files.

4. At the Welcome window, click Next.

5. If this is the first time you have installed DTA on this computer, specify the 
folder where you want to install it and click Next.

The installation program asks which of the following DTA components you 
want to install:

■ Client: This can be installed on one or more computers. It is installed 
on the server computer automatically when you install the 
server software.

■ Server: This must be installed on a single computer only.

6. Select the component you want to install on this computer and click Next. 

If you plan to install both client and server, install the server first.

If you select Server, the installation program lists the fully-qualified domain 
name (FQDN) and the data network port number for the computer it is 
being installed on. It will store this information in the DTA configuration files 
unless you clear the “Keep Server Settings” checkbox, click Next, and 
enter different information in the subsequent wizard pages.

NOTE:
Note the information you enter here; you will need it when you install the 
client.

The FQDN is the host name followed by the IP domain name. For example: 
dnapc1.department.company.com. 
If you do not know the IP address, find it as follows: on the Core Services 
computer, choose Start>Settings>Control Panel, double-click Network, 
click the Protocols tab, select TCP/IP, click the Properties button, and 
then click the IP address tab.

If you select Client: the installation program asks you for the host name and 
port of the DTA server. Enter the information you recorded when you 
installed the server clicking Next between pages.
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7. If this is the first time you have installed DTA on this computer, enter the 
name that you want to appear on the Programs folder (and Windows Start 
menu) for this application, or accept the default value, and click Next.

The installation program displays the Summary page.

8. Review the information you have entered, click Back to correct any 
information, and click Next when you are ready to install the selected 
component.

The installation program installs the selected DTA component. When it is 
finished, it displays the Setup Complete window.

9. To start the DTA server software immediately leave the checkbox checked 
and click Finish. To start the DTA server software at the next reboot, clear 
the checkbox and click Finish.

You can now install DTA on other computers in your network, using the same 
process.

Viewing Electronic Books Online

The DTA CD includes electronic copies of this book, plus the DEFINITY 
Enterprise Communications Server Release 9 ATM Installation, Upgrades, and 
Administration book. 

With this CD, you can:

■ read the documentation directly from CD

■ install the documentation on your computer

■ install it on a network server, so people can access it using your LAN or 
corporate intranet.

For instructions on performing any of the above options, refer to the readme file in 
the Documentation directory on the DTA software CD.

Uninstalling the Electronic Books

To remove the electronic books, complete the following steps:

1. From the Windows Start menu, select Programs>Avaya 
Documents>Uninstall DTA Documents.

If you installed the electronic books to a different location, select Uninstall 
DTA documents from wherever you installed them.

2. Click Yes to the confirmation dialog box.

The Uninstall program removes the documentation and indicates when the 
uninstall is complete.

3. Click OK.
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Shutting Down DTA

Before you uninstall DTA, you must shut down DTA. To do so, you must have 
access to the DTA server PC. To shut down DTA, complete the following steps:

1. Exit the client if it is open by choosing File>Exit.

2. Open an MS-DOS window.

Most likely, you can access this from the Windows Start menu, by choosing 
Start>Programs, MS-DOS Command Prompt.

3. At the prompt, type net stop “WSP Background Processes”

4. Wait a minute for the DTA server to shut down.

The MS-DOS window will display a message that the services are 
stopping. After the DTA server has shut down successfully, the MS-DOS 
window that says “DO NOT CLOSE THIS WINDOW” will also close. 

DTA will not notify users when it has shut down, but users will receive an error to 
this effect if they attempt to perform an action that requires the DTA server. The 
DTA server software will automatically start again after you reboot the server.

Starting DTA

You can start the DTA client or the DTA server. The DTA server must be running 
before you can start the client.

Starting the DTA Server

Once DTA is installed, the DTA server starts automatically each time you reboot 
your computer, and runs continuously unless you stop it manually. If you have 
stopped it manually and you want to restart it without rebooting your computer, 
complete the following steps:

1. Open an MS-DOS window.

Most likely, you can access this from the Windows Start menu, by choosing 
Start>Programs, MS-DOS Command Prompt.

2. At the prompt, type net start “WSP Background Processes”

3. Wait a minute for the DTA server to start.

The MS-DOS window will display a message that the services were started 
successfully. Then an MS-DOS window will appear that says “DO NOT 
CLOSE THIS WINDOW.” Do not attempt to close the window!



DEFINITY Translator ATM WSP Manager Release 3.0
Installation and Configuration  555-233-223  

Issue 1
December 2000

Installing DTA 
34Uninstalling DTA 

6

Starting the DTA Client

To start the client, choose Start>Programs>Avaya Enterprise Management> 
DEFINITY Translations Manager. If you installed DTA under a different Program 
Group name, select that instead.

Uninstalling DTA

To remove DTA from a computer, you must have Windows Administrator 
privileges.

1. If the DTA client is running on this computer, close it. 

2. From the Windows Start menu, select Settings>Control Panel.

3. Double-click Add/Remove Programs.

4. On the Install/Uninstall tab, highlight DEFINITY Translator ATM WSP 
and click the Add/Remove button.

5. Confirm that you want to remove the selected application.

If the selected application uses software components that are also used by 
another application, the system displays the Remove Shared File? dialog 
box. If you know that the shared file is not being used by any other 
application, you can delete it by clicking Yes or Yes to All.

6. Click OK.
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Configuring DTA

To configure DEFINITY Translator ATM WSP Manager (DTA), you will perform the 
following main steps. The rest of this chapter explain these steps in detail.

1. Set the PC’s time.

2. Start DTA.

3. Specify the main DEFINTY ECS system in the WSP network.

4. Provide connection and login information about each WSP.

Setting the PC’s Time

After DTA is installed, when people use it to schedule downloads to occur from a 
DEFINITY switch to its WSPs, DTA will execute the download according to the 
date and time that the user specifies. However, this date and time is the date and 
time at the PC where the DTA server software is installed. For this reason, it is 
highly advantageous for the DTA server PC to have the correct date and time set 
in the operating system.

To do so, complete the following steps:

1. Choose Start>Settings>Control Panel on your Windows PC.

2. In the Control Panel, double-click Date/Time.

3. Specify the date, time, and time zone using the dialog box.

4. Specify whether to automatically adjust for daylight savings time.

5. Click OK.
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Starting DTA

DTA’s server software will start automatically each time you reboot the server. 
DTA’s client software is accessible from the Windows Start menu, like other 
Windows applications.To start the client, choose Start>Programs>Avaya 
Enterprise Management> DEFINITY Translations Manager. If you installed 
DTA under a different Program Group name, select that instead.

Specifying the Main Switch

The first time you start DTA, it will ask you to specify the main DEFINITY switch. 
To do so, complete the following steps:

1. Enter the switch name.

2. Enter the switch’s IP Address.

To determine the switch’s IP address, you can ask your LAN/WAN 
administrator, or you can gather this information from the switch itself, as 
follows: Log in using your favorite system administration tool. Type display 
ip-interfaces and press Enter. Look for the C-LAN board and note the 
value in the Node Name field. Then type list node-names and press Enter. 
Look for the Node Name you noted from the previous screen. Next to it will 
be the IP Address for that C-LAN board. 

3. Enter the number of the IP Network port on this switch’s C-LAN board that 
DTA should use to communicate with this switch.

This is a IP Network port number (for example, 5000), not a switch port 
address. To determine the IP Network port, you can ask your LAN/WAN 
administrator, or you can gather this information from the switch itself, as 
follows: Log in using your favorite system administration tool. Type display 
ip-interfaces and press Enter. Look for the C-LAN board and note the 
value in the Node Name field. Then type display ip-services and press 
Enter. In the Local Node field, look for the Node Name you noted from 
the previous screen. Next to it, in the Local Port field, will be the IP 
Network port for that C-LAN board.

4. Check or clear the “Continue if save translation fails?” check box.

Before copying translations, DTA issues the save translations command 
on the main switch. If you check this box, DTA will copy the translations 
even if the save translations command fails on the main switch. If you 
leave this box empty, DTA will abort the copy if the save translations 
command fails.

5. In the Upload/Download area, and in the Administration area, specify the 
login IDs and passwords of the Upload/Download and Administration 
logins that you created (on page 23 and page 25) for the main switch.
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6. Check or clear the Use ASG check box.

ASG is an optional security feature on your DEFINITY ECS system. To 
determine if ASG is enabled on the main switch, see page 21. If you set up 
the logins on your main switch to use ASG, check this box. Otherwise, 
leave it empty.

7. Click Test Connectivity.

Clicking this button tests the connection between the DTA server and the 
main switch, for both the Upload/Download login and the Administration 
login. If you encounter any error messages, see ‘‘Troubleshooting’’ on page 
40. If there are no errors with connectivity, DTA will display the name, 
number, and link status of each WSP in the network, in the “Administration” 
tab of the main DTA window. DTA got this information from the main switch 
(assuming that someone has already entered this information in the main 
switch as part of Step 1 on page 15).

8. Click OK.

This saves the information you entered in this dialog box.

Specifying WSP Information

To finish configuring DTA, you must supply login and password information about 
each WSP, as follows:

1. Double-click a WSP from the list on the “Administration” tab.

DTA displays the DEFINITY WSP Properties dialog box. The name of the 
WSP is already displayed.

2. Enter the IP address, port, login IDs, passwords, and ASG information for 
this WSP, in the same way you did for the main switch.

3. Specify the WSP Take Over Time.

This is the amount of time you want this WSP to wait in the event of a main 
switch failure before the WSP comes up as a main processor. 

4. Click Test Connectivity.

This tests the connection between the DTA server and the selected WSP, 
for both the Upload/Download login and the Administration login. If you 
encounter any error messages, see ‘‘Troubleshooting’’ on page 40.

5. Click OK.
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Testing the Installation

To test that you have correctly installed and configured all the components of 
DEFINITY Network Administration (DTA), complete the following sections.

Testing Connections

To test DTA’s connections to supported devices, complete the following steps:

1. Start DTA (page 35).

2. Select a switch on DTA’s main screen.

3. Choose Tools>Validate.

DTA attempts to connect to the main switch, and if it is able to log in, it 
issues the status atm wsp command. If the WAN Processor Role field 
contains any value other than “pending,” then DTA can display the name, 
number, and link status of each WSP in the network.
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Troubleshooting

In the table below, find the symptoms in the left column and follow the instructions 
in the right.

Message Possible Causes and Solutions

Attempt to remove 
non-existing or un-writable 
file <translations file name>.

<1> After DTA uploads translations from a main 
switch, it makes a copy for each WSP and then, 
before it downloads the copy to each WSP, it 
modifies the translations slightly so they will work 
on the WSP. The listed errors can occur when 
DTA attempts to rename the uploaded 
translations, if: 

■ there was an error in uploading the 
translations and, in fact, no upload file really 
exists on the DTA server.

■ there was an error in the file system that 
either a) prevented the upload file from being 
written to the DTA server hard drive, or 
b) prevented the upload file from being copied 
and renamed to the WSP file name.

■ you or someone else changed your 
permissions after the DTA server software 
was installed and configured.

■ whoever set up the directory on the DTA 
server where the translations are uploaded 
didn’t share the directory with you.

Cannot replace file <new 
translation file name>

See <1>.

Error reading schedule type 
<type> starting schedule 
now

<2> You should never receive this message.  This 
error would appear if DTA is running a job that 
has a scheduling option that is no longer 
supported by DTA.  For example, if today’s 
release supports "Run Now," "Run Once," "Run 
Daily," and "Run Weekly," and a subsequent 
release supports only 3 options, then you might 
see this message. In that case, you can simply 
click the Schedule tab and either alter the 
schedule or leave it as is and click Submit.  By 
resubmitting the job, you will clear the error.
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Failed opening connection to 
<switch> with <connection 
state>.

<3> DTA may encounter problems connecting to a 
switch or WSP for any of the following reasons:·

■ the IP address, Network Port Number, default 
Gateway, or Subnet Mask in DTA no longer 
matches what has been administered in the 
switch or WSP, or on the LAN/WAN.

■ the login ID and password (and possibly ASG 
Secret Key) in DTA no longer matches what 
has been administered in the switch or WSP.·

■ a physical connection has been severed.

■ the switch or WSP is down.

■ the part of the DTA software that establishes a 
connection with a switch or WSP is 
experiencing problems.

Failed to create connection 
object for <system> 
<exception description>.

<4> This message can occur if DTA experiences 
difficulty building a connection file it uses to make 
a connection with the named device.  Contact 
Technical Support, tell them what you were doing 
when the incident occurred, and give them the 
exception description.

Message Possible Causes and Solutions
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Failed to retrieve ATM PNC 
board location from <WSP> 
<exception description>.

Failed to run atmwsp 
command on <system> 
<exception description>.

Failed to run busyout atm 
pnc command on <WSP> 
<exception description>.

Failed to run remove atm 
pnc command on <WSP> 
<exception description>.

Failed to run reset system 3 
command on <switch> 
<exception description>.

Failed to run save translation 
command on <switch> 
<exception description>

Failed to set system 
parameters for <WSP> 
<exception description>

<5> All of these are errors indicate that DTA was 
unable to issue a command on the listed switch or 
WSP. Information in the exception description 
may give a clue.  Possible reasons include:·

■ Someone upgraded the switch software but 
didn’t upgrade DTA, or vice versa (post 
Release 9)

■ There are problems with physical connectivity.

■ Someone entered the wrong connection 
information in DTA or on the switch or WSP 
(IP Address, Port, Subnet Mask, Gateway, 
login ID, password, or ASG Secret Key).·

■ Someone changed the connection information 
in DTA but not on the switch or WSP, or vice 
versa.

■ There are problems with the permissions 
assigned to the DTA login ID(s) that you 
created on the given switch or WSP.

You can either troubleshoot the problem yourself 
using the information provided in the exception 
description, or contact Technical Support and give 
the exception description to them.

File <translations file name> 
does not exist or is 
un-writable.See <1>

See <1>.

No network <network file 
path> or modem <file path + 
system> connection file(s) 
exist.

<6> DTA creates the network connection file when 
you install DTA.  Users cannot configure or modify 
this file.  You should never receive this message. 
If you do, the recommended process is to reinstall 
the DTA server. If that doesn’t work, call 
Technical Support and give them the exception 
description.

Message Possible Causes and Solutions
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The connection definition file 
<definition file> does not 
exist.

<7> DTA creates the connection definition file when 
you install DTA. Users cannot configure or modify 
this file.  You should never receive this message.  
If you do, the recommended process is to reinstall 
the DTA server. If that doesn’t work, call 
Technical Support.

The WSP returned an 
unknown Link Status 
<state>.

<8> This message is purely informational.  DTA can 
upload and download translations regardless of 
what the value in the Link Status field.

Schedule for <main 
DEFINITY> submitted.

<9> This message appears when you click the Submit 
button on the Schedule tab of DTA’s main screen.  
It simply confirms that DTA has received the 
change you specified. It does NOT mean that the 
job is starting.  Rather, the job will start when you 
specified for it to start.

Scheduled task failed while: 
uploading translations.

Scheduled task failed while: 
verifying WSP list – this 
message indicates a fatal 
condition which occurred 
during the upload 
translations step.

Scheduled task failed while: 
uploading translations: Save 
translations failed for <main 
DEFINITY>.  <main 
DEFINITY> set to stop task if 
translations save failed.

<10> All of these errors indicate that DTA was unable to 
copy translations from the main switch to the DTA 
server. The only difference between them is when 
in the upload process the error was detected.  
Contact Technical Support.

Scheduled task pending.  
Start time is: <date> -

<11> This message appears if you change a schedule, 
or when a schedule completes and it is set to run 
periodically.

Scheduled task started. <12> This message appears immediately before DTA 
begins copying translations from the main switch 
to the DTA server. It will stay in the history log 
until the history log fills and begins to overwrite 
the first entries.

Message Possible Causes and Solutions
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Translations download 
processing for <WSP> has 
failed. <exception 
description>

<13> This indicates that DTA was unable to copy 
translations from the DTA server to the given 
WSP. Information in the exception description 
may give a clue.  Possible reasons for the failure 
include:·Problems with physical connectivity·
Incorrect or changed connectivity information (IP 
Address, Port, Subnet Mask, Gateway, login ID, 
password, or ASG Secret Key)·Problems with the 
permissions assigned to the DTA login ID(s) on 
the given switch or WSP. You can either 
troubleshoot the problem yourself using the 
information provided in the exception description, 
or call Technical Support.

Translations upload 
processing for <main 
DEFINITY> has failed. 
<exception description>

See <10>.

Upload of translation from 
<main DEFINITY> has 
failed.

See <10>.

Updated schedule not 
started due to currently 
active schedule.

<14> This error means that DTA is already in the 
process of copying translations from a main 
switch to WSPs. Reschedule the job in question 
to start after the current job is complete.

Updated WSP list from 
<DEFINITY> received.

<15> Each time you start the DTA client, each time you 
choose Tools>Validate, and each time DTA starts 
to upload translations, DTA automatically 
contacts the main switch and verifies that DTA’s 
list of WSPs is still accurate.  When the switch 
returns the updated list of WSPs, DTA displays 
this informational message.

Message Possible Causes and Solutions
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administer C-LAN, 19 
Administer Features field, 27 
Administer Permissions field, 27 
Administer Stations field, 27 
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administering, 19 
installing, 18 
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testing, 39 

connectivity, testing, 37 
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conventions, typographical, 1 
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D 
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logins 
admin, 25 
enabling upload, 24, 28 
initialization, 23 
upload, 23 

preparing for DNA, 15 
testing 

See connecting to 
deinstalling, 34 
deleting DTA, 34 
Device Service 

removing, 34 
DHCP, 11 
direct connection ID number, 19 
Display Admin and Maint data field, 27 
display circuit 1 command, 6, 25 
display circuit pack command, 27 
display ip-interfaces command, 36 
display ip-services command, 36 
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download login, 23 
download translations command, 6, 23 
downloading, 32 

translations, 6 
DTA 

administering fields on WSPs, 6 
administrative login, 25 
configuring, 35 
connectivity, testing, 37, 39 
defined, 5 
installation, 31 
installation checklist, 8 
installation help, 10 
installation prerequisites, 29 
modifies translations, 6 
preparing switches for, 15 
shutting down, 33 
specifying WSP information, 37 
starting, 33, 34 
uninstalling, 34 

dynamic IP address, 11 
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electronic books, 32 
downloading, 32 
installing, 32 

error messages, 40 
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features, enabling 
ASG on your switch, 21 
DNA on your switch, 22 
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forced-standby mode, 6 

H 

hardware 
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See DEFINITY, DEFINITY AUDIX, or 
Intuity AUDIX 

hardware, connecting, 13 
help with installation, 10 
hot-swappable pack, 18 
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initialization account 
creating, 23 
enabling, 24, 28 

installation 
checklist, 8 
C-LAN, 18 
getting help, 10 
help, 10 
overview, 8 
planning, 29 
preparing switches, 15 
prerequisites, 29 
testing, 39 

installation prerequisites, 1 
installing, 31 

documentation, 32 
Intuity AUDIX 
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See connecting to 

IP address, 18, 36 
static or dynamic, 11 

IP addresses 
overwriting, 6 

L 

LAN requirements, 12 
list node-names command, 36 
Local Node field, 36 
Local Port field, 36 
login 

administrative, 25 
Login Type field, 23, 25 
Login’s password field, 23, 25 
logins 

admin, 25 
creating upload/download, 23 
enabling initialization, 24, 28 
enabling upload, 24, 28 
initialization, 23 
upload, 23 

loop-back host, 29 
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Maintain System field, 27, 28 
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manuals 
downloading, 32 
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IP address, port, node name, 6 
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network type, 11 
node name 

how DTA modifies, 6 
Node Name field, 36 
NT servers, placing, 29 
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documentation 

installing, 32 
removing, 34 
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installing, 32 
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opening DNA, 36 
operating system, 11 
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ASG on your switch, 21 
DNA on your switch, 22 
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more copies of this book, 4 
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overview 

configuring DNA, 35 
overview, installation, 8 
overwriting connectivity information, 6 
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phone numbers, 21 
phone numbers, sales support, 21 
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planning, location of NT servers, 29 
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prerequisites, installation, 1, 29 
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more copies of this book, 4 
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remote service, 12 
remove atm pnc 1 command, 6, 25, 27 
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documentation, 34 
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for remote troubleshooting, 29 
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switch and WSP, 12 

reset login-ID command, 19 
reset system 3 command, 6, 25, 27 
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S 

save translations, 5 
save translations command, 6, 25, 27, 36 
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secret key, 24, 26 
security, 7, 30 
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Standby 
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Refreshed field, 17 
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status atm wsp command, 6, 25, 27 



DEFINITY Translator ATM WSP Manager Release 3.0
Installation and Configuration  555-233-223    

Issue 1
December 2000

Index 
48 
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adding upload login, 23 
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upload translations 

translations 
upload command, 5 

uploading 
translations, 5 

V 

viewing, 32 
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